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Database basics in Visual Basic.NET
Tutorial 1:  Creating a new database connection

All work using VB .NET to control a database is dependant upon making a connection between your program and the database.  In this first tutorial, we’ll see that it is quite straight-forward to make a successful connection using tools and techniques which are made easy in the Visual Studio .NET environment.  

This tutorial will take about 10 minutes to complete.  It is suggested, however, that you do this and the second tutorial together.  We can’t see a connection, and so things don’t get too interesting until we actually see data on screen.  How to display data when the connection is made will be shown in the next tutorial;  this first tutorial deals only with the fundamental building block of all database work: making the connection.
1.
To get started, we will look at how to create a new solution, and a new project within that solution.  It is handy to be able to create multiple projects within one solution, especially if they are logically related.  If you know how to do this, you can create a new solution named ‘Tutorials’ and a project within it called ‘tute01’ and then safely skip down to point 6.

1
Open Visual Studio .NET

2
Create a new solution.  Call the solution ‘Tutorials’.
3
View your Solution Explorer.  One way of doing this is by using the key combination Control-R.  What you’ll see will be something like this:
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4
Right click on the solution name (‘Tutorials’), which will allow you to add a new project, as shown:
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5
Create a new Project.    Make sure that in the Templates window a Windows application has been chosen.  Call the project tute01.

Go to the designer window (View > Designer, or Shift-F7).

We now have a solution, a project, and a simple form.  We’re ready for the database work.
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6
We are at the stage of creating a data connection to a database.

(A database called Contacts may have been supplied with this tutorial.  If not, it doesn’t matter for our present purposes, but select one of your Access databases to which you want to make a connection.)
The following outlines the procedure by which a data connection can be made.

7
Show the Server Explorer, by following the menu path


View > Server Explorer

or by using the key combination 


Control-Alt-S.

The Server Explorer will look something like the following, though the specific connections made may well be different:
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8
With the mouse, Right-click on Data Connections, and select Add Connection from the drop down menu:
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Selecting “Add Connection” will call a pop-up dialog like the one shown here:
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9
As an Access database is going to be used, we need to specify that.  To do so, click on the Provider tab, and select Jet 4.0 OLE DB provider:
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10
Now click on the Next >> button shown in the above figure, to return to the Connection tab page (or simply click the Connection tab).
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11
Enter a valid database name.  The button to the right of the text box enables you to browse through directories until the required database is located.

12
When the database has been selected, the connection can be tested by clicking on the test connection button:
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If the connection is successfully made, you will see a message box like that following:
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13
When the connection is successful, click on the OK button at the bottom of the Data Link Properties pop-up dialog.
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14
Drag the desired connection shown in the Server Explorer onto your form.

The barred circle in the diagram above is seen as the connection is being dragged but hasn’t yet reached a destination which can receive it.

When you have dragged it over the form, the barred circle is replaced;  releasing the mouse now will drop the connection onto the form.
[image: image9.png]orm1..vb [Des

Selected, Records - Microsoft Visual Basic .NET, [design]

e fh Vew Popn Did Db Db D Do wndow ek
G-t-cE0 &8 ) oo < on
P |<8]2) |8 serveresplorer || B searchResuks | |3 Toobox
——

Eo%s

= 3 Data Connections

- 8 ACCESS,C:|Documents and Settinsle. iy DocLments{DBDIContacts.mb.Adin
G ACCESS,C:|Prooram FiesiMicrosoft OffcetOffce10|Samplesiorthvind.mb. Adrin

5 B servers

5 B secwbiehmis
% CrytalServces

EventLogs
S8 Hessage Queues
Perormance Cotrters

R servies





You may be shown a pop-up dialog asking whether you want the inclusion of a password in the connection string.  For our purposes, it is recommended that you do not include a password.
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The success of the operation is graphically represented by the data connection being shown below the form area:

Conclusion:  What you’ve learnt so far is important, since all database work is based on accurately making a connection to a database.  But perhaps it isn’t very satisfying, because we haven’t put our knowledge to use in a way that we can see the results.  That’s we’re we’ll get to in the second tutorial, so, if you have the time to do so, I suggest you move on to that straight away.
Database basics in Visual Basic.NET
Tutorial 2:  Displaying data from a connected database
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In the first tutorial, we created a new solution for our database tutorial work, created a new project as a Windows application, and created a new database connection. 
For this tutorial, continue working on the project, tute01, in the solution Tutorials.
It is assumed that the database connection has been successfully dropped onto a form, as represented in the tray beneath the form, as shown at left.

It is also assumed that the connection made is for an Access database, with Microsoft Jet 4.0 OLE DB Provider chosen (as shown in the previous tutorial).  This second tutorial will use a database called Contacts.mdb, which may have been supplied with this tutorial.  However, the techniques are generic for Access databases and if you don’t have Contacts.mdb you should be able – with some intelligence – to use another Access database of your choice.
The easiest way to show the information in a database is to show all the information in one of its tables;  to show selected database records is a little more complex, and will be handled in a following tutorial.  For now, though, we will see how easy it is to show the data of a database table using VB.NET’s tools.

First, a connection is required.  This has already been made.
Secondly, a data adapter is required.  The data adapter is used for selection of the records to be displayed, and for the selection of which of the records’ fields are to be displayed.
1.
Open the Server Explorer.

2.
Select the connection required, and expand the database to show its tables:
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3.
Drag-and-drop the table of the database from the Server Explorer onto your form.  (In the example shown, the desired table is called “Contacts”)

The tray beneath the form will now show the connection object, here OleDbDataAdapter1: 
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Thirdly, a DataSet object is required.  It stores a copy of the data from the database.
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4.
After clicking on the form to ensure that it has focus, right-click on the OleDbDataAdapter that has been created, here given the default name – amazingly enough – OleDbDataAdapter1.

Click on the Generate Dataset menu item.
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5.
The dataset is given the default name DataSet11.  Ensure that the table desired is selected for inclusion in the dataset (the “Contacts” table in this example).

The click on the OK button.

Fourthly, a data grid control is needed for the display of the data.
6.
Open the toolbox, if not already open, and place a data grid control onto the form.
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7.
You can then size and place the data grid control.
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 8.
The control must now be linked up to the data.  In order to do this, open its properties window (for example, by right-clicking on the data grid control and choosing the properties menu item).

9.
Set the data source property menu to DataSet11,
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10.
Set the data member property to the name of the database table to be used (in this case, “Contacts”):
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11
Double-click somewhere on the form (not on the data grid), to open a stub for coding for the form load event.  Within the stub, add code so that it is similar to the following:

  Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles MyBase.Load

    DataSet11.Clear()

    OleDbDataAdapter1.Fill(DataSet11)

  End Sub
12.
Run the program to see the contents of the table displayed in the data grid.
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Hopefully, what you see will be similar to the above.  If so, you have successfully used VB .NET to provide a front-end to an Access database.

Database basics in Visual Basic.NET
Tutorial 3:  Displaying selected fields of a database table
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Some Preliminaries:

In this project, we want to display only selected fields from a database table, not all the fields.

If you’ve have just been working on the second tutorial, some data objects appear in the tray below the form’s designer (as shown at right).  These need not concern us in moving on to this third tutorial.
We begin by creating a new project called tute03 in the solution (‘Tutorials’) that we have been using for the first two tutorials.  The default form will be renamed SelectedFields.vb The first few steps describe how to do all this, and may be skipped if you know how to create tute03 in the Tutorials solution, set it as the start-up project, and rename the form.
[image: image54.png]\SELECT  Boolean, Chronos, Firsthame, Gender, LastName, [Humber], StudentID
FROM Studeris

WHERE (Lasthame = Bronr)

ORDER BY Lasthame




1.
First, create a new project.  This can be done by opening up the Solution Explorer, right-clicking on the solution (‘Tutorials’) and clicking the option to add a new project:
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Create a windows application project and name it tute03.
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2.
If you then check the Solution Explorer, you will see that the new project has been added with a new form, the form being given the default name, Form1.vb.   If you right-click on its icon in the solution explorer, you can rename it to something more meaningful.  For our project, rename it as SelectedFields.vb

Notice, too, that the new project is not shown in bold in the solution explorer.  In the figure at left, the project previous project created under this solution is called tute01 and is shown in bold.  The bold indicates which project is the start-up project.  
It is important to change the start-up project to the new project.  [image: image56.png]Dot | Formet ook window H
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If you don’t change the start-up project in the solution, confusion can result.  When you next compile, perhaps after doing all the work to complete the new project, the old project will run;  the results shown on screen won’t reflect the work you’ve done on the new project.  It can be somewhat bewildering until you realise that your new work is not displayed only because the start-up project hasn’t been reset.

3.
To set the new project as the start-up project, in the Solution Explorer, right-click on the new project (tute03), and click on the menu item to set it as the new startup project.

Now it’s time to give the project the functionality required.

Displaying the Selected Fields:

4.
Open the toolbox (for example by using the Control-Alt-X combination) and open the data tab to display its range of controls.  Select an OleDbDataAdapter and drag-and-drop it onto the form. 
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5.
A wizard will be called which will guide us through the process, as shown at right.

Click on its Next button.

6.
Select the desired connection, or create a new connection according to your requirements.  For this example, I’ll be using the Contacts database:
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Having chosen or created your connection, click Next.
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7.
The default option on the next screen is  Use SQL statements, and we will be accept this option for this project.

SQL stands for “Structured Query Language”.  It needn’t sound frightening as the Wizard will go on to do the work for us.

Click the Next button to proceed.
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This can look a bit daunting – an imposing question above a blank text box.

But we are also offered a Query Builder, and it’s this that will do the hard work for us.  You will later see the results in the text box;  if you take notice of the results generated by the Query Builder, you can gradually learn how to write your own queries.

8.
Click the Query Builder button.
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9.
The Contacts database which is being used for this project has a table called Students.  Select that table by clicking on the Add button (as shown at the bottom of the figure at right), and then click on the Close button.  (As many tables can be added to the selection as needed;  when all required tables are added, use the close button.)

10.
The Query Builder is shown, displaying the fields of the selected table.  Scroll down through the fields, selecting those wanted for display.  As they are selected, you’ll see your changing selections reflected in the Query Builder.  In this example, three fields will be chosen:  FirstName, LastName, and StudentID.  

11.

When all desired fields are chosen, click on the OK button.
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The question that had been intimidating before, “What data should the data adapter load into the dataset?”, has now been answered for you.

It’s at this point that you can observe how the query is built, so that you can build your own skill in writing SQL queries.

12.
Click on the Next button to go on.
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At this point, a friendly screen will confirm that the data adapter has been successfully configured.

13.
Click on the Finish button.

14.
Create a new data set.

How to do this was covered in sections 4 and 5 of the second tutorial.  But this time we’ll do it a different way, so that you can then choose for the future which way you prefer.
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Follow the menu path


Data > Generate Dataset

A popup dialog appears; after checking that its default options reflect your requirements, click on OK.

The data set will be given the name, DataSet11, by default, but you may chose to alter this.

15.
From the Control toolbox, select the Windows Forms tab and drag-and-drop a DataGrid onto your form.  Set its DataSource and DataMember properties appropriately.  (These steps were covered in detail in tutorial 2, steps 6-10).
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16.
Add a button to the form, so that the form may look similar to the following:
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17.
Double-click on the button to create a code stub, and add code within the stub so that when complete it is as follows:

  Private Sub Button1_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles Button1.Click

    DataSet11.Clear()

    OleDbDataAdapter1.Fill(DataSet11)

  End Sub

Now, when the user clicks on the button, the data from the table will be loaded into the data grid.

18.
Compile the project to see its results, which will be displayed when you click on the button.
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Editing and Saving data in the selected fields:

With a minimum of effort it is possible to make the project more valuable, by enabling it to accept changes to the actual information and to save these changes.

19.
Change the Text property of the Button to Load.

20.
Add another button to your form, and set its text property to Save

21.
Code this second button’s on-click event as follows:

  Private Sub Button2_Click(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles Button2.Click

    OleDbDataAdapter1.Update(DataSet11)

  End Sub
If you run the project, add some data, stop your project and re-run it in order to check, you will find that your newly added data has been correctly saved and reloaded.  Easy!

Database basics in Visual Basic.NET
Tutorial 4:  A little bit of SQL

Some Preliminaries:

In this project, we are going to explore a little bit of SQL – “Structured Query Language”.

We have already seen how we can instruct the data adapter to show only specified fields.

But we will often want to go further than that – specifying what records to select, and the order in which these are to be displayed.  Just as SQL was the tool that enabled us to specify which fields were to be displayed, it is SQL which will enable us to specify which records are selected for display, and the order of the display.

1.
Create a new project named tute04 
2.
Ensure that it is set as the start-up project.  
3.
Name its default form Students.

4.
Using the techniques described in tutorial three, open the toolbox and open the data tab; drag-and-drop an OleDbDataAdapter onto your new project’s form.  Connect to the Contacts database and, using SQL statements, configure the data adapter to show all the fields of the Students table.

5.
Create a new data set (section 14 in tutorial 3).

6.
Place a data grid on the form, and set its data source and data member properties appropriately (sections 6-10 in tutorial 2).

7.
Place a button on the form which will clear the data set and fill the data adapter from the data set. (Section 17 in tutorial 3).
Your form should look something like that shown here:
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When the project is run, and the button is clicked, you should see a data display similar to the following:
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Going a little further with SQL:

We’re now ready to explore the techniques that will allow us to choose only selected records, and to order the information as we wish.

In the tray under the form designer will be something similar to this:
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When the OleDbDataAdapter1 was created through being dragged-and-dropped from the Data tab page of the Control toolbox, a wizard was displayed which allowed us to configure the adapter.

If we had to start from scratch each time we wanted to change the configurations, the process would be so tedious that we’d drop databases in favour of old-fashioned 5 x 3 inch index cards.
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It’s important to realise that the information to be displayed (which we set by the SQL entered through the Query Builder which was presented as part of the process of following the data adapter wizard) is not set in concrete, a never-to-be changed law of the Medes and Persians.

8.
Right-click on the OleDbDataAdapter (given the default name of OleDbDataAdapter1 in the tray underneath the windows form designer).

9.
Choose the configure Data Adapter option

A familiar wizard appears:  
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10.
On successive screens presented by the wizard, click on the Next button until the screen is reached which allows SQL statements to be generated, and which displays the  Query Builder button:
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11.
Click the Query Builder button.
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If you set your project up properly the settings will appear as above.

Let’s now set the order in which the records are to be displayed.  It’s easy.

12.
At the intersection of the Sort Order column and the LastName row, click the mouse once to see a drop down menu displays as follows:
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13.
Click on the 1, as highlighted above, and this results in the following:
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Notice that the word Ascending has been added to the Sort Type column, and in the SQL summary we have a new item:


ORDER BY  LastName
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Click OK on the Query Builder page.

14.
Click on the Next button;  a confirmation should be given that the data adapter was configured successfully.  Then click on the Finish button.

15.
Run the project and click on the button to load the data.  It should now be displayed according to alphabetical order of surname:
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16.
Now let’s use the Query Builder again, this time to filter the records.  Follow steps 8 to 11 again in order to reopen the Query Builder.

17.
In the cell that is the intersection of the LastName row and the Criteria column, type in the name ‘Brown’, as shown:
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Click in another cell, and notice what happens in the cell in which you entered the name ‘Brown’:
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The syntax is automatically changed to reflect that syntax required and used by SQL.
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Also updated is the SQL summary.  Notice the WHERE condition;  observing the syntax displayed in the Query Builder is a helpful way of learning SQL syntax that can later be put to use in writing your own, more complex SQL queries.

18.
Complete the configuration of the data adapter and test the project.  The data displayed should now be as follows:
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19.
Now, use the data adapter’s Query Builder again;  emend the criterion so that instead of records being selected if they have the surname Brown, they surname is greater than C:
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When the data is loaded, its display will be like this:
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You should now have some confidence in entering SQL queries using the Query Builder, and it is time to move on in expanding your techniques.
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20.
Notice that it is not necessary to run the program in order to check whether the query is selecting those records you require, and those only.

Use the menu path   Data > Preview Data.

In the popup dialog that is then displayed, click on the Fill Dataset button;  this will result in the selected records being displayed, as in the figure below:
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Use the Close button to exit this dialog.

Similarly, there is an alternative to opening the wizard to use the Query Builder for the entry or update of the SQL query.

21.
Right-click on the data adapter item in the tray beneath the form, and select the properties menu item:
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Scroll down to find the SelectCommand property:
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Click on the box containing a plus sign immediately to the left of the SelectCommand property, in order to expand it to reveal its details.  Now click on the CommandText property.
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Click on the button which displays the three dots…  and you’re back in familiar territory, with the Query Builder, yet without having to go through as many other other steps to access it.

But there is an alternative to clicking on the button with the three dots.  You can simply enter or emend the SQL query in the text box to the CommandText property.  In the figure below, the query is altered to display only those names greater than I (> ‘I’):
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When this is entered, you will be prompted with an input dialog: Do you want to regenerate the Parameters collection for this command?

Click the ‘No’ button..

When the properties have been set, you can use the menu path Data > Preview Data  to check the effect of the emended query on the selection of data.

Summary:

In this tutorial,

· We looked in more detail at the use of SQL queries

· We saw a range of different ways to enter the SQL query into a data adapter

· We saw some different ways of calling the display of the data to test whether the query appropriately gathered the desired records;  particularly, we saw that it is not necessary to run the project in order to see what records are selected by the query.

At a more general level, it should now be becoming obvious how a deeper understanding of SQL will help in increasingly proficient selection of data.  You can see, then, that at some stage this little bit of SQL will need a sequel…
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